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About Us 
Hexagon Geospatial helps you make sense of the dynamically changing world. Hexagon 
Geospatial provides the software products and platforms to a large variety of customers through 
direct sales, channel partners, and Hexagon businesses, including the underlying geospatial 
technology to drive Intergraph Security, Government & Infrastructure (SG&I) industry solutions. 
Hexagon Geospatial is a division of Intergraph Corporation. 

CUSTOMERS. Globally, a wide variety of organizations rely on our products daily including 
local, state and national mapping agencies, transportation departments, defense organizations, 
engineering and utility companies and businesses serving agriculture and natural resource 
needs.  Our portfolio enables these organizations to holistically understand change and use 
information to make mission and business-critical decisions.   

TECHNOLOGY. Our priority is to deliver products and solutions that make our customers 
successful. Hexagon Geospatial is focused on developing leading-edge technology that is easily 
configurable. Through extensible, scalable and collaborative products, we enable you to 
transform multi-source content into dynamic and actionable information. We are constantly 
re-conceptualizing and improving our products. 

PARTNERS. As an organization, we are partner-focused, working alongside our channel to 
ensure we succeed together.   We provide the right tools, products and support to our business 
partners so that they may successfully deliver sophisticated solutions for their customers.  We 
recognize that we greatly extend our reach and influence by cultivating channel partner 
relationships both inside and outside of Hexagon.   

TEAM. As an employer, we recognize that the success of our business is the result of our highly 
motivated and collaborative staff.  At Hexagon Geospatial, we celebrate a diverse set of people 
and talents; and we respect people for who they are and the wealth of knowledge they bring to 
the table. We retain talent by fostering individual development and ensuring frequent 
opportunities to learn and grow.    

HEXAGON. Hexagon Geospatial plays a key role in Hexagon’s multi-industry focus, leveraging 
the entire portfolio for a wide variety of geospatial needs. Hexagon is a leading global provider of 
design, measurement and visualization technologies.  Synergistic thinking is encouraged 
across all levels and functions at Hexagon companies, so that we all respond better and faster 
to our shared customer’s needs. 

For more information, visit www.hexagongeospatial.com (http://www.hexagongeospatial.com) 
and www.hexagon.com (http://www.hexagon.com). 

http://www.hexagongeospatial.com/
http://www.hexagon.com/
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Corridor Analysis Tutorial 

Performing a Corridor Analysis Using Grid Analysis 

Corridor Analysis and Transportation Planning 

Transportation is an intrinsically spatial activity, making GIS a natural tool. Departments of 
Transportation use GIS tools to support a range of functions, including traffic monitoring and 
management, infrastructure planning and maintenance, safety and accident analysis, and 
vehicle routing. Some of these functions are essentially computerized versions of the paper map 
processes they replace, while others take advantage of the unique capabilities of GIS. 
Increasingly, Departments of Transportation are using GIS as decision support tools. 

A number of Departments of Transportation have begun using GIS as part of the highway 
corridor planning process. This process has become very complex, and often has the potential 
to be contentious. The location of a highway corridor must take into account not only traffic 
demand and traditional engineering requirements, but also a range of environmental, cultural, 
social, and economic factors. While the DOT may "own" the process, other agencies generally 
supply the environmental and cultural data and are active participants in evaluating and 
choosing alternatives. Public participation is frequently an important part of the process, as well. 

Traditionally, the corridor planning process has started with a preliminary project design based 
on transportation needs and engineering constraints. The proposed corridor is then presented to 
regulatory and/or resource agencies for assessment of environmental, heritage, and cultural 
impacts. This is followed by a series of iterations, in which different corridor plans are evaluated, 
debated, and modified. The process is often lengthy and expensive. 

This tutorial presents an alternative process, one that includes environmental concerns as part 
of the initial corridor location decision. The core concept is that costs can be assigned to building 
a roadway through each type of land use area, and a least-cost path between pre-defined start 
and stop points can be determined. These costs can include not only the traditional land 
acquisition and construction costs, but costs associated with mitigating environmental damage, 
acquiring compensatory acreage, performing archeological surveys, and so forth. This 
alternative method has a number of advantages. 

 The method integrates environmental and human considerations at the beginning of the 
process, rather than as "add ons." 

 All the relevant data is presented in a single context. 

 Agencies that are part of the decision process can make sure that their data – in which 
they have confidence - is included as part of the design process. 

 The decision making rules are transparent. Costs assigned to building through different 
land-use zones are clearly defined. Alternate cost values can be used, and the resulting 
corridors compared. "What if" scenarios can be generated efficiently. 

 Different output options – including displaying proposed routes against an aerial photo 
image backdrop or in 3D using GeoMedia 3D – are available, providing powerful 
communication tools. 
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 GeoMedia coupled with grid capabilities and unparalleled ability to access diverse data 
forms, provides an exceptional environment for this type of analysis. 

 

 
 

Tutorial Introduction 

This tutorial demonstrates a workflow used to identify the least-cost routing of a highway 
corridor, taking into account terrain, land use, and environmental considerations. Hints will be 
provided on data size, appropriate resolution for different-sized Study Areas, and presentation. 

Topics covered in this tutorial include: 

 Opening a GeoMedia GeoWorkspace 

 Importing Ohio Department of Transportation (DOT) data to create a Study Area 

 Using the Recode command to assign relative costs of traveling through different land 

use zones 

 Using the Grade command to assign cost to topography 

 Using the Calculator to generate a total cost surface 

 Using the Distance/Cost command to create least-cost paths 

 

Tutorial Text Conventions 

There are several conventions used throughout the tutorial: 

 Ribbon bar items are shown as: On the Aaa tab, in the Bbb panel, click Ccc > Ddd. 

 Dialog box names, field names, and button names are depicted using bolded text. 

 Information to be entered, either by selecting from a list or by typing, is depicted using 
italicized text. 

 

Tutorial Data Set 

The tutorial data set, provided by the Ohio Department of Transportation, depicts Guernsey 
County, Ohio, including the area around Salt Fork State Park.  

  The provision of data by the Ohio Department of Transportation (DOT) does not imply 
sanctioning by the Ohio DOT, nor is it an endorsement of Intergraph Corporation, or of its 
products. 
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How This Tutorial Should be Used 

This tutorial is ideal for those with an interest in route planning or corridor analysis. 

Users of this tutorial should have a good working knowledge of GeoMedia Desktop, and should 
ideally have worked through the Learning to Use Grid Analysis introductory tutorial. 
 

Data Preparation 

Opening a GeoWorkspace 

Grid Analysis is completely integrated with the GeoMedia Desktop and is available when 
GeoMedia Advantage or GeoMedia Professional tiers are used. The Grid Analysis commands 
are located in the Grid drop-down menu. 

To begin this tutorial: 

1. Launch GeoMedia Desktop and choose Open an existing GeoWorkspace from the 
Welcome menu. 

2. Double click the More Files… option, browse to \Grid Analysis Tutorials\Introductory 
Tutorials\Corridor Analysis\Corridor Planning.gws, and click Open. 

3. If a GeoMedia error message requests the database filename, browse to \GeoMedia Grid 
Tutorials\Introductory Tutorials\Corridor Analysis \CorridorPlanningData.mdb, click Open, 
and click OK when prompted.  

4. Repeat step 3 for GridLayers.mdb. 

The Map window will display vector data for Guernsey County, Ohio. The Start and End points 
for a proposed highway corridor are shown with green and red dots. The analysis will determine 
the least-cost path between these two points, based on environmental, land use, and terrain 
costs. 
 

Importing Data Files to Create a Study Area 

A Study Area must be defined and active before grid analysis can take place. The Study Area 
specifies the location, greatest possible extents, cell resolution, and geographic projection of the 
grid layers belonging to it. One way to define a Study Area is to import data. When a grid layer is 
imported, a Study Area based on that layer’s parameters is created and made active. 

1. On the Grid tab, in the Study Area panel, click Import. 

2. Select the Import multiple files option. 

3. To select the files to import, click Browse, and navigate to \Grid Analysis 
Tutorials\Introductory Tutorials\Corridor Analysis, and click OK. 

4. Select GeoMedia Grid (*.mfm) from the Format drop-down list. 

5. Two files, AirPhoto.mfm and DEM.mfm, appear in the Available files list. 

6. Click the >> button to add both files to the Selected files list. 
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7. Click Next. 

Some data file formats do not include coordinate system definition information. In order to 
import these files, a separate GeoMedia Coordinate System File must be supplied. 

8. Click Browse, navigate to \Grid Analysis Tutorials\Introductory Tutorials\Corridor Analysis, 
select the UTM17N NAD83.csf file, click Open, and then click OK. 

9. A dialog box appears showing the current read-write connections Corridor Analysis and 
Grid Layers. 

10. Expand the list hierarchy under Corridor Analysis. 

11. Inside the Corridor Analysis connection is a Study Area that is named, by default, Study 
Area 1; it contains the DEM and AirPhoto layers. 

12. Click on the text Study Area 1 and once it expands and highlights, drag this element to the 
connection called Grid Layers. Once this action is complete, the system will store all of the 
meta data information regarding this new Study Area in the connection called Grid Layers.  

13. Click Next >.  A final dialog box appears with a report giving information about the imported 
layer and the new Study Area. 

14. Click Finish to conclude the import process.  

HINT:  The size of a grid file and its cell resolution are inextricably linked. For a given data set, 
the finer the resolution (that is, the smaller the grid cell), the greater the detail shown and the 
larger the file. Because the size of the file affects processing efficiency, it is important to select 
an appropriate cell resolution for the task at hand. Cell resolution can be changed using Grid 
Analysis Reproject/Copy command. When a layer is copied into a Study Area using this 
command, it is reprojected to conform to the coordinate geometry and cell resolution of the new 
Study Area. 

In this tutorial, the analysis is performed on an approximately 4km by 7.5km area. The cell 
resolution of 20m is appropriate, given the distances involved and the 20m cell resolution of the 
provided DEM. All the processes executed in this tutorial will complete in a few minutes or less. 
It would be possible to perform this workflow at a resolution of 10m, but the DEM would need to 
be reprojected to a resolution of 10m, and the associated processes would take more time to 
complete. 
 

Rasterizing Vector Feature Classes to Grid Layers 

In the previous step, a DEM and aerial photograph were imported. These layers will provide 
elevation data for the analysis and visual context for the results. Now, feature classes will be 
rasterized to provide land use information and start and end points for the proposed highway 
corridor. Only the vector data falling within the boundaries of the Study Area will be rasterized, 
producing grid layers with the location, extents, cell resolution, and geographic projection 
specified. 
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1. Before rasterizing, go to the Grid tab, in the Study Area panel, and click List to open the 
Study Area List window. This window displays all the Study Areas in the workspace, the 
grid layers belonging to each Study Area, and which of the Study Areas are currently active. 
As new grid layers are created, they appear in this list. 

 

2. In the GeoMedia Map window legend, click on WetlandsInventory by GRID_CODE. 

3. On the Grid tab, in the Layer panel, click Rasterize Legend Entries. The new grid layer will 
not be visible in the Map window, but will be added to the active Study Area and listed in the 
Study Area List.  

 

4. In the Map window legend, click on LandCover by GRID_CODE. (The display of this legend 
entry has been turned off to minimize Map window refresh time. If you wish to view the 
feature class, right click on the legend entry, and choose Display On.) 

5. On the Grid tab, in the Layer panel, click Rasterize Legend Entries. Note that the name of 
the new grid layer – "LandCover by GRID_CODE" – appears in the Study Area List 
window. 

6. In the Map window legend, click on Start, and shift-click on End. 

 

7. On the Grid tab, in the Layer panel, click Rasterize Legend Entries to rasterize both 
feature classes simultaneously. 
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All the data from the required feature classes are now available as grid layers that are part 
of the active Study Area – "StudyArea1." 

 

HINT:  To rasterize more than one feature class at a time, select them using "ctrl-click". 
GeoMedia Analysis allows "ctrl-click" and "shift-click" entry selection in all its windows. 
 

Preparing Cost Surface Grid Layers 

Most of the Grid Analysis commands produce a new grid layer, which is automatically added to 
the active Study Area. In this section, Grid Analysis commands will be used to create layers that 
represent the cost of building a highway, taking into account terrain, land use, and 
environmental factors. 
 

Viewing Attribute Values 

When a feature class is rasterized, each cell of the resulting grid layer has a value equal to the 
Primary Key of the vector object with which it spatially coincides. The other attribute data for the 
feature class is linked to the grid layer, and is available for grid analysis. The attribute data 
associated with a feature class can be viewed in the GeoMedia Data window. 

1. On the Home tab, in the Windows panel, click New Data Window. 

2. In the New Data Window dialog box, select the feature class LandCover, and click OK. 

3. In the resulting data window, scroll until the columns GRID_CODE, ID2, and 
GC_Description are visible. 

The ID2 column is shaded, indicating that this is the Primary Key. These are the values that 
supply the cell values of the grid layer derived from the feature class. The values in the 
GRID_CODE column indicate land use category, and GC_Description is text, labeling each land 
use category.  
A summary of the GRID_CODE values, the GC_Description labels, and the relative cost of 
building a highway through each type of land use area is provided below. 

GRID_CODE value Land Use Category Relative Cost 

1 Urban High 

2 Agriculture Moderately low 
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3 Shrub/Scrub Very Low 

4 Wooded Low 

5 Open Water Very High 

6 Non-forested Wetland Very High 

7 Barren Very Low 

4.  Close the data window by clicking Close. 
 

Using the Recode Command to Assign Relative Cost Values to Land Cover 
Categories 

The Recode command has two main functions: explicit value extraction and explicit value 
reassignment. It generates a result layer in which each cell is assigned a specific value based 
on its value in the source layer. This command is often used in layer editing. 

In this workflow, Recode will be used to assign specific cost values to land cover and wetlands 
categories. Later, these values will be combined to produce a layer that gives the total cost of 
traveling over these areas. 

1. On the Grid tab, in the Analysis panel, click Classification > Recode. 

2. From the drop-down list, select LandCover by GRID_CODE as the Source layer. 

3. Select GRID_CODE as the Attribute of the Source layer. 

4. Assign new values, representing the relative costs shown in the table above, to these zones 
as follows: 

 Assign 5000 to Value 5 (Open Water, very high cost) 

 Assign 5000 to Value 6 (Non-Forested Wetland, very high cost) 

 Assign 1000 to Value 1 (Urban, high cost) 

 Assign 10 to Value 2 (Agriculture, moderately low cost) 

 Assign 5 to Value 4 (Wooded, low cost) 

 Assign 1 to Value 3 (Shrub/Scrub land, very low cost) 

 Assign 1 to Value 7 (Barren, very low cost) 

5. Type Land Cover Costs as the Result layer name. 

6. Clear the check mark from Place results in map window. 
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7. Click OK. The command will execute. Notice that the grid layer name now appears in the 
Study Area List window. 

8. On the Grid tab, in the Layer panel, click Edit to check the results. 

9. Select Land Cover Costs from the Edit Grid Layer list, and click Edit. 

10. Examine the grid layer. The cell values of the five zones represent the relative costs of 
building a highway through that type of land cover. 

 

11. Close the Edit window. If prompted to save changes, click No. 
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Using the Recode Command to Assign Relative Cost Values to Wetlands 
Categories 

The GRID_CODE attribute of the WetLandsInventory feature class identifies different wetlands 
categories. The attribute values, wetlands categories, and the relative costs of building a 
highway through them are summarized below. (If desired, these attributes can be viewed in the 
GeoMedia Data window.) 

GRID_CODE value Land Use Category Relative Cost 

1 Upland Areas Very Low 

35 Open Water Very High 

36 Shallow Marsh Very High 

37 Shrub/Scrub Wetland Very High 

38 Wet Meadow Very High 

39 Farmed Wetland Very High 

1. On the Grid tab, in the Analysis panel, click Classification > Recode. 

2. From the drop-down list, select WetLandsInventory as the Source layer. 

3. Select GRID_CODE as the Attribute of the Source layer. This will access data that 
identifies the wetlands categories. 

4. Assign new values, representing relative costs, to these zones as follows: 

 Assign 1 to Value 1 (Upland Areas, very low cost) 

 Assign 5000 to Value 35, 36, 37, 38, 39 (All Wetland Categories, very high cost) 

5. Enter Wetlands Costs as the Result layer name. 
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6. Clear the check mark from Place results in map window. 

 

7. Click OK. The command will execute, and the grid layer name Wetlands Costs will appear 
in the Study Area List window.  

8. On the Grid tab, in the Layer panel, click Edit to check the result. 

9. Select Wetlands Costs from the Edit Grid Layer list, and click Edit. 

Examine the grid layer. The values of the two zones represent the relative costs of building 
a highway through wetlands versus non-wetlands areas. Although similar to the layer Land 
Cover Costs, this layer provides cost information specific to wetlands.  

 

10. Close the Edit window. If prompted to save changes, click No. 
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Using the Grade and Recode Commands to Assign Costs to Topography 

The Grade command returns a slope value for each cell in a source layer of continuous data. 
You can choose Average slope, Horn slope, or Maximum slope results, expressed in percent 
slope or degrees. 

When applied to a Digital Elevation Model (DEM), Grade produces a layer in which each cell 
value represents the gradient of the terrain represented by that cell. 

The result of the Grade command makes it possible to assign a topography cost. Steep slopes 
are more expensive to build on than are flat areas, and they also add to the total distance that 
must be traversed. 

1. On the Grid tab, in the Analysis panel, click Surface > Grade. 

2. From the drop-down list, select DEM as the Source layer. 

3. Enter the Result layer name Average Slope. 

4. Clear the check mark from Place results in map window. 

5. Accept all other defaults. 

 

6. Click OK. 

7. On the Grid tab, in the Layer panel, click Edit to check the results. 

8. Select Average Slope from the Edit Grid Layer list, and click Edit. 
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9. Examine the grid layer. Scan the layer with the Query Raster Values tool. The cell values 
represent average cell slope, expressed in percent. This is relevant to the cost of building 
over them. 

 

10. Close the Edit window. If prompted to save changes, click No.  

11. On the Grid tab, in the Analysis panel, click Classification > Recode. 

12. Use the drop-down list to enter Average Slope as the Source layer. 

 Assign 1 to Values 0…3. (low cost to relatively flat slopes) 

 Assign 100 to Values 4…7 (high cost to steep slopes) 

 Assign 500 to Values 8…15 (higher cost to steeper slopes) 

 Assign 5000 to Values 16… (prohibitively high cost to extreme steep slopes) 

13. Enter Grade Costs as the Result layer name. 

14. Clear the check mark from Place results in map window. 
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15. Click OK. The command will execute. If desired, the resulting grid layer can be viewed using 
the Edit window. 

 

Using the Calculator to Generate a Total Cost Surface 

The Calculator is used to perform Layer, or Overlay Math: mathematical operations and 
functions involving grid layers and constants. The operations are performed on every cell in the 
specified grid layer or layers. For example, when a grid layer is multiplied by 1000, the value of 
each cell in the output layer is equal to the value of the corresponding input cell, multiplied by 
1000. When one grid layer is subtracted from another, the value of each cell in the output layer 
is equal to the difference of the values of the corresponding cells in the input layers. 

The Calculator will be used to add together the cost layers that have been created in the 
previous steps, creating a total cost layer. 

1. On the Grid tab, in the Analysis panel, click Calculator. 

2. By double clicking on layer names and clicking on function buttons, enter the mathematical 
statement "Land Cover Costs" + "Wetlands Costs" + "Grade Costs". 

3. Type Total Costs into the Result layer Name field. 

4. Clear the check mark from Place results in map window. 

 

5. Click OK. 
The resulting layer will include costs associated with building a highway that come from land 
use, wetlands, and steepness of terrain.  

6. On the Grid tab, in the Layer panel, click Edit to check the results. 

7. Select Total Costs from the Edit Grid Layer list, and click Edit. 

8. Examine the grid layer. Scan the layer with the Query Raster Values tool. The cell values 
represent the total relative cost of building over the terrain represented by those cells. 
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9. Close the Edit window. If prompted to save changes, click No. 

 

HINT:  The cost values used here are arbitrary. In practice, professionals with expert and local 
knowledge determine cost values. Different cost values can produce significantly different 
corridor routing results. 

Also note that, when adequate information exists, actual monetary cost values can be assigned. 
When this is done, the cost values equal the cost of building a highway through a specific type 
of land cover, or terrain, or land use region. 
 

Grid Analysis – Finding a Least-Cost Path Between 
Specified Points 

The Distance/Cost command measures distance incrementally, from cell to cell, taking into 
account a number of optional factors that can include vertical distance, specified networks, and 
the cost of moving from one cell to the next. 

The many options of Distance/Cost can be used independently or in combination, allowing for a 
wide variety of inputs and results. This command is a powerful tool for data creation, spatial 
analysis, terrain analysis, and surface propagation modeling. 

To determine the least-cost path between the designated Start and End points, Distance/Cost 
will be used twice. First, the Distance/Cost command, using the Total Cost layer and the "Path 
back" option, will generate a layer showing the least-cost path from each cell in the grid layer 
back to the Start point (the green dot in the GeoMedia Map window, represented in the grid 
layer Start). Each cell value of the output layer will indicate the direction the least-cost path 
would take, from this cell to the next, on its way to the Start point. 

Second, the Distance/Cost command, using the "Path back" layer to define a network, will 
produce a grid layer defining the unique least-cost path going from the End point to the Start 
point. 
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A Note on Determining Maximum Distance: 

HINT:  Maximum distance is a mandatory parameter for the Distance/Cost command. It 
specifies the maximum distance (or cost) that will be measured from the starting point or points. 
Some analyses require that paths be limited to a predetermined length; for others, it is 
necessary to include all the cells of the layer. 

For this analysis, the Maximum distance value should be large enough to ensure that all the 
cells of the input layer are evaluated. This value can be determined by finding the product of the 
largest possible straight-line distance in the layer (the diagonal distance from corner to corner) 
and the largest possible cost value. 

 

All the grid layers in this analysis have the same number of rows and columns. On the Grid tab, 
in the Study Area panel, click Select to find these values. Make sure that the Connection is 
Grid Layers, and the Study Area is StudyArea1. Look at the Size field. The grid layers in this 
Study Area have 201 rows and 381 columns. Close the dialog box. 

To find the highest cost value, open the layer Total Costs in the grid Edit window. Scroll the 
legend to view the largest value in the layer – 15000. Close the Edit Window and, if prompted to 
save changes, click No. 

Using these values: 

     

Using a Maximum value of 6 481 805 or larger guarantees that every cell of the input layer will 
be evaluated. For simplicity, this analysis will use a rounded value of 7 000 000. 

1. On the Grid tab, in the Analysis panel, click Path > Distance/Cost. 

2. From the drop-down list, select the Source layer name Start. 

3. Enter a Maximum distance value of 7000000 Cells. 

4. Using the drop-down list, select the With cost layer name Total Costs. 

5. Name the Result layer Path Back to Start. 

6. Click the radio button for the Return option Path back. 

7. Clear the check mark from Place results in map window. 
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8. Accept all other defaults. 

 

9. Click OK. 

  This command is CPU-intensive, and may take a few minutes to run.  

10. On the Grid tab, in the Layer panel, click Edit to check the results. 

11. Select Path Back to Start from the Edit Grid Layer list, and click Edit. 

12. Examine the grid layer. All cells are now encoded with values indicating the direction of the 
least-cost path from that cell back to the Start point. This layer will be used as input for the 
next step in the analysis. 

 

The Grid Analysis Edit window includes a tool to help you visualize paths information. To use it: 

1. Click the Show/Hide Path Direction Arrows button . 
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2. Click the Zoom Ratio button  to display the zoom ratio choices, and choose a zoom 
ratio of 1:16 (also works on the Numeric Magnifier). Path direction arrows will now display 
on the grid layer. These arrows are visible only at a zoom ratio of 1:16. 

 

3. Close the Edit window. If prompted to save changes, click No.  
 

Using the Distance/Cost Command to Generate a Proposed Corridor 

The Distance/Cost command can now be used to identify the least-cost path from the End point 
back to the Start point and to compute the total cost associated with that path. 

1. On the Grid tab, in the Analysis panel click Path > Distance/Cost. 

2. From the drop-down list, select the Source layer name End. 

3. Enter a Maximum distance value of 7000000 Cells. 

4. Using the drop-down list, select the Out of network layer name Path Back to Start. 

5. Use the drop-down list to enter Total Costs as the With cost layer name. 

6. Name the Result layer Proposed Corridor. 

7. Select the Return option Distance/cost. 

8. Clear the check mark from Place results in map window.  
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9. Accept all other defaults. 

 

10. Click OK. 

11. On the Grid tab, in the Layer panel, click Edit to check the results. 

12. Select Proposed Corridor from the Edit Grid Layer list, and click Edit. 

13. Examine the grid layer. The non-VOID cells represent the proposed corridor from the End 
point to the Start point. Use the Query Raster Values tool to examine the cell values of the 
corridor. The value of each cell represents the cost of traveling from the End point to that 
cell. In this example, the values are relative, rather than actual, costs. When the relevant 
information is available, these values can be actual dollar costs.  

 

14. Close the grid Edit window. When prompted to save changes, click No. 
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Viewing the Proposed Corridor in Context 

The proposed corridor can be viewed in context; for example, against a backdrop of the vector 
data, or an air photo of the area. 

1. On the Grid tab, in the Layer panel, click Display. 

2. In the Display in Map Window dialog box, select Proposed Corridor and click OK. The 
proposed corridor will now be visible in the GeoMedia Map window, and will also be listed 
as the first entry in the legend. 

 

3. The visual impact of the proposed corridor would be greater if it were a uniform color. On the 
Grid tab, in the Layer panel, click Edit to display the proposed corridor in the grid Edit 
window.   

4. In the grid Edit window legend, click on the legend entry with value 0; then scroll to the 
bottom of the legend, and shift-click on the last entry. This selects all non-VOID entries in 
the legend. 

5. Right click to display the context menu, and choose Change Colors. 

6. The Color Picker dialog box will open. To assign the color black to all non-VOID cells in the 
grid layer, make sure that 0 is entered in the % fields for Red, Green, and Blue components 
of the color. (These should be the values present when the dialog box opens.) 

7.  Click OK.  
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8. Click Save to save the changes and to close the grid Edit window. 

Notice that the proposed corridor now displays in the Map window as a uniform black. 

Other grid layers can be used a backdrops to give context and to better communicate the 
results. 

9. On the Grid tab, in the Layer panel, click Display. 

10. Select AirPhoto and click OK. The AirPhoto grid layer will now display as the top layer in 
the Map window and will be listed as the first entry in the legend. 

11. To reposition AirPhoto in the Map window, click on the grid layer name AirPhoto in the 
legend, and drag it so that it is the fourth entry in the legend, below Proposed Corridor, 
Start, and End. 

 

12. To make the proposed corridor visible, a new color must once again be assigned. 

13. Display the layer Proposed Corridor in the grid Edit window. 

14. In the grid legend, select all the non-VOID entries. 

15. Right click the selected entries to display the context menu, and choose Change Colors. 

16. Click System to display the system color choices. 

17. Click a bright yellow color square; then click OK to return to the Color Picker dialog box. 

18. In the Color Picker dialog box, click OK to assign bright yellow to all the non-VOID cells in 
the layer (that is, the proposed route for the highway corridor.) 
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Click Save to save the new color assignment, and close the grid Edit window. Notice that 
the proposed corridor is now shown as bright yellow, providing a good contrast with the air 
photo. 

 
 

Other Ways in which Grid Analysis can Support Corridor 
Planning 

The workflow presented here shows one way in which defining the least-cost path between two 
points can help define a potential highway corridor. There are many other grid functions that can 
be used with this type of analysis to help support the decision process. Some of these are 
suggested here. 
 

Using Elevation Data When Identifying a Least-Cost Path 

The Distance/Cost command can include the Over Surface Layer parameter, which specifies 
a grid layer of elevation values, such as a DEM. When this parameter is used, all distance 
calculations include vertical, as well as horizontal, distances.  

This results in a more realistic computation of distance, especially when the route is through hilly 
or mountainous terrain. However, using this parameter will also increase the processing time 
required. 
 

Including Viewshed Information in a Corridor Planning Analysis 

Often it is important to plan a transportation corridor for minimum impact on a region’s visual 
resources, especially when the route is through or near wilderness or park lands. The Viewshed 
command can be used to define those areas that are visible from specified viewing points or 
areas.  

The resulting grid layer can be processed by assigning appropriate costs to visible and invisible 
areas and can be used as input for the total cost layer. 

For more information on using Grid Analysis to identify viewsheds, see the mini-tutorial 
"Performing a Viewshed Analysis." 
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Using Grid Editing Tools to Modify a Proposed Corridor 

Developing and evaluating alternative scenarios is an essential part of the planning process. 
Grid analysis can be used to generate different proposed corridors, based on different cost 
assignments.  

Sometimes, though, it is useful to make minor adjustments to the results of these analyses "by 
hand." When a proposed corridor layer is displayed in the grid Edit window, a range of drawing 
tools is available and can be used to make changes to the route. 

The Grid Analysis Help (Grid Analysis Help Topics) file describes the grid editing tools and 
how to use them. 
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Comparing the Costs of Different Proposed Corridor 

It is useful to be able to compare alternative corridor routings, not only visually, but also 
numerically. When the Distance/Cost command is used to identify the least cost path, the value 
of each non-VOID cell of the output layer is the cost of the route up to that point. This means 
that the highest value in the layer is the cost of the route from start to finish.  

The Zonal Score/Maximum command can be used to create a layer depicting the route, in 
which the value of the cells making up the route are the total cost of the route.  

A combination of the Recode, Distance/Cost, and Zonal Score/Maximum commands can be 
used to determine the cost associated with a "hand-edited" route, as well. Being able to assign a 
numerical value to different routes can help facilitate the decision making process. 
 

Viewing Results in 3D 

Planning a transportation corridor typically requires input and consensus from a number of 
agencies or departments, as well as from members of the public. This means that ability to 
present and visualize different alternatives is very important. GeoMedia 3D is a powerful 
communication tool that can be effectively used to visualize these results in 3D.  

Using a combination of elevation, context (air photo, land use, environment, viewshed, etc.), and 
proposed corridor layers, the 3D view enables users to visualize the proposed routes and how 
they interact with the environment. The view can encompass the entire route or zoom in on 
specific portions of it. 
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